
Lesson Skill Matrix

Skill Exam Objective Objective 

NumberProtecting and Sharing 

Documents 

Restrict editing.

Mark a document as final.

Protect a document with a 

password.

1.2.1

1.2.2

1.2.3

Managing Document Versions Manage document versions. 1.1.3

Software Orientation

The Bottom Line

In Word 2016, Backstage provides commands that enable you to sign in to your Microsoft account; 

protect, inspect, and share documents; and manage versions of your documents as shown in Figure 

3-1.

Figure 3-1

Backstage 

Use Figure 3-1 as a reference for this lesson.

Protecting and Sharing Documents
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Protecting a Document

There might be a time when you need to set a password for sensitive documents. These 

documents can include payroll, budgets, employee evaluations, or hiring agreements. 

There are two different options for protecting a document: Save As Tools and Restrict 

Editing. Documents such as these are meant for certain individuals who have been 

granted permission; all others are denied access. Those granted access to confidential 

documents are provided a password to open and modify the document. 

When you save a document, you can save it with a password that enables users to open 

the document as read only. Individuals who receive the document can read the 

document, but they cannot modify it. If you want certain individuals to be able to edit 

the document, then a different password is needed for them to open the file in 

read/write mode. Managing documents with passwords helps you oversee sensitive 

tasks while maintaining security for the documents. You can also restrict the type of 

editing that users can perform in a document by using the Restrict Editing command.

Setting an Access Password for a Document

One way to secure confidential material, is to protect a document with read only and 

read/write passwords. In this exercise, you learn to set and remove encrypted passwords 

for a document containing an evaluation form.

Step by step          Set an Access Password for a Document

SAVE the document as Peer Review Draft in the lesson folder on your flash drive.1.

Click the File tab and then click Save As.2.

On the Save As screen, click This PC and then click Browse. The Save As dialog box 

appears.

3.

In the Save As dialog box, click the Tools drop-down arrow.4.

Select General Options from the context menu. The General Options dialog box 

appears (see Figure 3-2).

5.

In the Password to open text box, type Pa$$w0rd. Once you enter a password to 

open and/or modify the document, the file will be encrypted. When a file is 

encrypted, the data is converted to a code.

6.

GET READY. OPEN the Peer Review document from the lesson folder.

Protecting and Sharing Documents
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Figure 3-2

General Options dialog box

Word enables you to specify two different passwords—one to open a document 

and one to modify a document—and both are optional. You can specify passwords 

for both actions—or just specify a different password for each action. Passwords 

are case-sensitive, which means you can specify upper and/or lowercase letters. For 

this exercise, use the same password to open and modify the document. In the 

Password to modify text box, type Pa$$w0rd.

7.

Click OK. The Confirm Password message box appears.8.

In the Reenter password to open text box, type Pa$$w0rd and then click OK.9.

Another Confirm Password message box appears, this time for the modify 

password.

10.

In the Reenter password to modify text box, type Pa$$w0rd and then click OK.11.

In the Save As dialog box, click Save and CLOSE the file.12.

Open the Peer Review Draft file again. A Password message box appears, 

prompting you to enter a password to open the document (see Figure 3-3).

13.

Figure 3-3
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Figure 3-3

Password prompt to open a protected document

Type Pa$$w0rd in the text box and then click OK. The Password message box 

appears again.

14.

Type Pa$$w0rd in the text box and then click OK. The document opens.15.

PAUSE. LEAVE the document open to use in the next exercise.

Step by step          Remove a Password

Click the File tab and notice that the Protect Document button is highlighted in a 

light yellow color. Under Protect Document, it states, "A password is required to 

open this document."

1.

Select Save As and then click the Browse button to open the Save As dialog box.2.

Click the Tools drop-down arrow and then select General Options from the menu.3.

Remove the password protection by selecting each of the hidden passwords in turn 

and then pressing Delete.

4.

Click OK.5.

SAVE the document as Peer Review 1 in your flash drive in the lesson folder.6.

You now have two copies of the same document: one with a password and one 

without.

7.

GET READY. USE the Peer Review Draft document that is open from the previous 

exercise.

PAUSE. LEAVE the document open to use in the next exercise.

Take Note

It is important for you to remember the password you use to protect your documents. If 

you forget the password, Microsoft cannot retrieve it for you. Record and store your 

passwords in a safe location, such as a security safe or a secure place at home. Use 

strong passwords that combine uppercase and lowercase letters, numbers, and symbols. 

Weak passwords do not mix these elements. An example of a strong password is W5!

dk8aG; a weak password is CAR381. Passwords should be 8 or more characters in length. 

A password phrase that uses 14 or more characters is better.

Protecting a Document as Read Only

Safeguarding your documents is one way to protect them from individuals seeking to 

change the content and format. As you learned, you can encrypt a document with 

passwords that provide read only or read/write access to the document. Another way to 

protect a document is to restrict editing. This enables users to open the document 

without a password, but the types of changes they can make to the document are 

limited. 

For example, you might want to limit formatting changes to specific styles, or you might 

want users restricted to adding comments only, filling in forms, or making changes that 
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want users restricted to adding comments only, filling in forms, or making changes that 

are tracked. It's your choice as to whom you share the document with and what type of 

restrictions you put in place. In this exercise, you learn to set a document as read only, 

limit the document to comments only, and restrict formatting in the document.

Step by step          Protect a Document as Read Only

OPEN Backstage and then click Protect Document to display the context menu (see 

Figure 3-4).

1.

Figure 3-4

Protect Document menu

Formatting restrictions: Enables you to specify what type of formatting 

changes are permitted. 



Editing restrictions: Enables you to specify what type of editing changes are 

permitted.



Start enforcement: Enables you to apply the settings you have created in the 

first two items.



Click Restrict Editing. The Restrict Editing pane appears on the right side of the 

screen (see Figure 3-5). The pane contains three numbered items, as follows:

2.

GET READY. USE the Peer Review 1 document that is open from the previous exercise.
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Figure 3-5

Restrict Editing pane

Under Editing restrictions, select the Allow only this type of editing in the 

document checkbox. By default, No changes (Read only) is selected as the first 

option and the Exceptions (optional) heading appears.

3.

Under Start Enforcement, click Yes, Start Enforcing Protection. The Start Enforcing 

Protection dialog box appears, as shown in Figure 3-6.

4.

Figure 3-6

Start Enforcing Protection dialog box

Take Note

If your computer is set up to use Information Rights Management (IRM) by your 

administrator, the Start Enforcing Protection dialog box contains two options. The 

Password option shows that by adding a password, the document will not be 

encrypted. The User authentication option adds encryption to the document, with 

the restricted access preventing sensitive documents from being printed, forwarded, 

or copied.

Type Pa$$w0rd in the Enter new password box and the Reenter password to 

confirm box. Click OK. The Start Enforcing Protection button turns on the specified 

restriction, in this case making the document Read only. The document is now 

5.
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restriction, in this case making the document Read only. The document is now 

protected from any editing and you can view only this region. A region is the 

location in the document that you are allowed to edit. The Restrict Editing pane 

displays two available options: Find Next Region I Can Edit and Show All Regions 

I Can Edit. These display the areas in your document that you have been granted 

permission to edit. 

Click the Find Next Region I Can Edit button and notice that Word states that it has 

finished searching the document—there were no regions highlighted. Click OK.

6.

Click the Show All Regions I Can Edit button and no regions are highlighted. This is 

a read only document, so no editing is allowed.

7.

Click the Stop Protection button at the bottom of the pane. An Unprotect 

Document dialog box appears.

8.

In the Password text box, type Pa$$w0rd and then click OK.9.

Clear the Allow only this type of editing in the document checkbox.10.

CLOSE the Restrict Editing pane.11.

SAVE the document as Peer Review 2 in your flash drive in the lesson folder.12.

PAUSE. LEAVE the document open to use in the next exercise.

Step by step          Restrict a Document with Comments Only

On the Developer tab, in the Protect group, click the Restrict Editing button. The 

Restrict Editing pane appears.

1.

Select the Allow only this type of editing in the document checkbox.2.

Click the drop-down arrow and then select Comments.3.

In the Start Enforcement section, click the Yes, Start Enforcing Protection button. 

The Start Enforcing Protection dialog box opens, which turns on the set restriction 

for comments only.

4.

Type Pa$$w0rd in the Enter new password (optional) box and in the Reenter 

password to confirm box. Click OK. Only comments can be added to the region.

5.

Click Show All Regions I Can Edit; the insertion point moves to the heading. 6.

Select Jill A. Williams and on the Review tab, in the Comments group, click the New 

Comment button. A new comment box appears. 

7.

Type Jill's middle initial is E. The comment appears in the comment box.8.

Click the Stop Protection button at the bottom of the Restrict Editing pane. The 

Unprotect Document dialog box appears.

9.

Type Pa$$w0rd and then click OK.10.

Clear the Allow only this type of editing in the document checkbox.11.

SAVE the document as Peer Review 3 in the lesson folder on your flash drive.12.

GET READY. USE the Peer Review 2 document that is open from the previous exercise.

PAUSE. LEAVE the document open to use in the next exercise.

Step by step          Limit Formatting Styles in a Document

In the Restrict Editing pane, in the Formatting restrictions section, select the Limit 1.

GET READY. USE the Peer Review 3 document that is open from the previous exercise.
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In the Restrict Editing pane, in the Formatting restrictions section, select the Limit 

formatting to a selection of styles checkbox. Selecting this option enables you to 

set formatting restrictions for this document.

1.

Click the Settings link. The Formatting Restrictions dialog box appears, as shown in 

Figure 3-7. The check marks indicate that all styles are allowed.

2.

Figure 3-7

Formatting Restrictions dialog box

In the Formatting section, select the Block Theme or Scheme switching checkbox

and then click OK. Selecting this option blocks the user from making any changes 

to the structure, pattern, or theme of the document. A prompt appears, stating that 

This document may contain formatting or styles that aren't allowed. Do you want to 

remove them?

3.

Click Yes. On the Design tab, in the Document Formatting group, notice that the 

Themes button is grayed out, making it unavailable.

4.

In the Restrict Editing pane, click Settings again to open the Formatting Restrictions

dialog box.

5.

Clear the Block Theme or Scheme switching checkbox and then click OK.6.

Click OK. The same prompt appears as before.7.

Click Yes. Notice that the Themes button is now available. You can now use the 

Themes commands in the group.

8.

In the Formatting restrictions section of the Restrict Editing pane, clear the Limit 

formatting to a selection of styles checkbox.

9.

CLOSE the Restrict Editing pane.10.
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CLOSE the Restrict Editing pane.10.

SAVE the document with the filename Peer Review 4 in the lesson folder on your 

flash drive.

11.

On the Design tab, in the Document Formatting group, change the Style Set to 

Lines (Simple).

12.

The headings, Employee Information, Review Guidelines, and Evaluation are not 

displaying correctly in the table.

13.

On the Table Tools - Layout tab, in the Cell Size group, change the cell height to 

0.30 to accommodate the content in those three cells.

14.

On the Home tab, in the Styles group, change the font color for Heading 3 to 

White, Background 1 and bold.

15.

Leave the document open for ten minutes. Later in this lesson, you learn about 

managing document versions.

16.

Minimize the document to place it on the taskbar. You will use this document later 

in this lesson.

17.

PAUSE. LEAVE Word open for the next exercise.

Take Note

You can restrict comment creation to a whole document or you can select portions of 

the document in which editing changes are allowed.

Step by step          Mark a Document as Final

SAVE the document as Review Form 1 in the lesson folder on your flash drive.1.

Click the File tab, click Protect Document, and then click Mark as Final. A dialog box 

appears indicating that this document will be marked as final and then saved.

2.

Click OK. A Microsoft Word message box appears. Marking a document as final 

prevents recipients from making changes to the document—the document 

becomes read only, as displayed on the title bar. When a document is marked as 

final, the status property is set to Marked as Final and typing, editing commands, 

and proofing marks are turned off. 

3.

Click OK. The document is Marked as Final and displays in the Protect Document 

section highlighted in a light yellow color to discourage editing. 

4.

Return to the document and notice the yellow bar below the Ribbon indicating 

that An author has marked this document as final to discourage editing. Notice also 

that the Marked as Final icon appears on the status bar.

5.

Click any of the tabs on the Ribbon and notice that the controls are greyed out, 

indicating that the commands are not available.

6.

Select the title of the document and try to delete it. When a document is marked as 

final, typing, editing commands, and proofing marks are disabled, because the 

document becomes a read-only document. Notice that the title bar also shows the 

document as Read-Only.

7.

Click the File tab, click the Protect Document button, select Mark as Final to return 

the document to its original status, and then return to the document.

8.

GET READY. OPEN the Review Form document from the lesson folder.
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the document to its original status, and then return to the document.

Select the B in Blue Yonder Airlines and then press the Delete key. You can now 

make changes to the document.

9.

Click the Undo button on the Quick Access Toolbar.10.

SAVE the document with the same filename in the lesson folder on your flash drive.11.

PAUSE. LEAVE the document open to use in the next exercise.

Take Note

Documents that have been marked as final in a Microsoft Office 2016 program will not 

be read only if they are opened in versions of Microsoft Office programs prior to 2013. It 

is important to recognize that the Mark as Final command is not a security feature—

anyone who receives an electronic copy of a document that has been marked as final 

can edit that document by removing the Mark as Final status from the document.

Applying Protection Using the Ribbon

Encryption protects a document so that it cannot be opened without a password.

Step by step          Encrypt a Document

Go to Backstage, click the Protect Document button, and then select Encrypt with 

Password.

1.

The Encrypt Document dialog box appears (see Figure 3-8). Encrypting protects the 

document by making it unreadable, using a code that is only reversible using the 

password you specify.

2.

Figure 3-8

Encrypt Document dialog box

In the Encrypt the contents of this file text box, type Pa$$w0rd and then click OK.3.

Retype the password and then click OK. Notice that Protect Document is 

highlighted and indicates that a password is required to open this document.

4.

CLOSE the document.5.

Click Save when prompted.6.

REOPEN the document by typing Pa$$w0rd when you are prompted to do so.7.

GET READY. USE the Review Form 1 document that is open from the previous exercise.
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REOPEN the document by typing Pa$$w0rd when you are prompted to do so.7.

Take Note

To unprotect the document, you must already be inside the document (with the 

correct password). From within the document, click the File tab, click the Protect 

Document button, select Encrypt with Password, delete the password from the 

dialog box, and then click Save.

SAVE the document as Review Form 2 in the lesson folder on your flash drive and 

then CLOSE the file.

8.

PAUSE. LEAVE Word open to use in the next exercise.
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Microsoft has simplified the tasks of retrieving a document by versions or recovering an 

unsaved file. Have you accidently deleted your whole document or turned off your 

computer before saving? Word can help you retrieve your document by using the 

managed versions. You can manage document versions in Backstage by using the Info 

command and then selecting which version to save. Word also provides the ability to 

recover unsaved documents by automatically saving them every ten minutes by default. 

You will be able to recover versions of your document as long as you haven't closed 

your document or program. Also, if the Word program stops working for some reason, 

then you will be able to recover your document, but you will not see your previous 

versions until you save the document. Under Manage Document, you can also browse 

for unsaved files. In this exercise, you manage a document's versions with an existing file 

and a new file and recover an unsaved version.

Managing Document Versions

The AutoRecovery command provides flexibility in saving your Word documents, 

including making more frequent backups. In this exercise, you will learn how to change 

the default Save settings from 10 minutes to 3 minutes. 

Step by step          Manage Document Versions

Click File to go to Backstage view. On the Info screen, under Manage Document, 

you should see the times the document was saved.

1.

Click Close without saving and keep Word open. Closing the Word program would 

cause you to lose your versions of the Peer Review 4 document

2.

OPEN the Peer Review 4 document from your flash drive in the lesson folder.3.

Go to the Backstage Info screen (see Figure 3-9). Notice that Manage Document 

shows when the document was last saved. 

4.

GET READY. On the taskbar, CLICK the Peer Review 4 document to make it the active 

document. Remember, you minimized this document previously in this lesson. The 

document should have been left open for 10 or more minutes.

Managing Document Versions 
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Figure 3-9

Versions without saving

In the Backstage view, select Options to open the Word Options dialog box.5.

From the list in the left pane, select Save (see Figure 3-10).6.
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Figure 3-10

Word Options Save screen

By default, the Save AutoRecover information every setting is 10 minutes. Also, the 

Keep the last autosaved version if I close without saving checkbox is selected. In 

step 3, you closed the document without saving and when you reopened and 

reviewed the Managed Document, it showed when the document was last saved 

using Autosave.

7.

In the Save documents section, change the default 10 minutes to 3 minutes.8.

Click OK.9.

Create a new blank document and then type Working with unsaved documents can 

be found in Backstage on the Info screen.

10.

Keep this document open for 10 minutes.11.

On the View tab, click Switch Windows and then select the Peer Review 4

document.

12.

Return to Backstage and under Manage Document, you should see at least one or 

two versions of the document saved.

13.

SAVE the document as Peer Review 5 in the lesson folder on your flash drive.14.

PAUSE. LEAVE the document open for the next exercise.

Take Note
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Take Note

Clicking the down arrow key in Manage Document enables you to Recover Unsaved 

Documents; the Open dialog box opens files specifically from the location where 

unsaved files are saved.

Restoring an Earlier Version of Your Document

The Save AutoRecover feature in Word 2016 saves documents automatically by time, 

displaying them as Today (current date). In the previous exercise, you changed the Save 

AutoRecover setting from the default of 10 minutes to 3 minutes. As you modify your 

document, AutoRecover saves changes every 3 minutes. Word saves the updates in 

different versions , which you can locate in Backstage under Manage Document. In this 

exercise, you restore an earlier version of your document.

Step by step          Restore an Earlier Version of Your Document

Select the Blue Yonder Airlines heading. 1.

Change the font color to Dark Blue, Text 2.2.

Increase the font size to 28 pt.3.

Where Jill A. Williams' name appears, replace the middle initial A. with E.4.

Change the review period date from Dec 20XX to April 20XX. You have to modify 

the document for Save AutoRecover to save the updated changes.

5.

Go to Backstage and under Manage Document, click a version that indicates 

(autosave). A new window appears, showing a bar below the Ribbon that says 

Autosaved Version—A newer version is available (see Figure 3-11). When you click 

the Compare button, a summary appears that compares the original document and 

the revised document. The Restore button prompts you to overwrite your previous 

document. 

6.

GET READY. USE the Peer Review 5 document that is open from the previous exercise.
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Figure 3-11

Autosaved Version

Click Restore to overwrite your previous document. A message box appears, 

prompting you to confirm that you want to overwrite the last saved version with 

the selected version. 

7.

Click OK.8.

CLOSE the document.9.

PAUSE. LEAVE Word open for the next exercise.

Recovering Unsaved Documents

As you continue working on documents, you can browse or recover unsaved files 

through Manage Document in Backstage. You can also open a document based on the 

time or the last version within that session. In this exercise, you recover an unsaved 

document.

Step by step          Recover Unsaved Documents

Previously, you typed Working with unsaved documents can be found in Backstage in the 

Info screen in a new document and you changed the Save AutoRecover information from 

the default 10 minutes to 3 minutes.

Click Don’t Save.1.

Click the File tab and then click Open.2.

Scroll down to the bottom of the screen and then click Recover Unsaved 3.

GET READY. CLOSE the document that you typed. A prompt to save your document 

appears. The prompt states, If you click "Don't Save," a recent copy of this file will be 

temporarily available.
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Scroll down to the bottom of the screen and then click Recover Unsaved 

Documents. An Open dialog box appears (see Figure 3-12).

3.

Figure 3-12

Open dialog box for unsaved files

Locate your file based on the date and time you closed the document or program 

or locate Working with unsaved documents can be . . .. You closed the document 

without saving it with a filename; therefore, the name will show the first part of the 

text that you typed. Word places unsaved documents in a temporary location on 

your hard drive and gives them an ASD file extension.

4.

Select the unsaved document and then click Open. The document opens with the 

Recovered Unsaved File prompt appearing below the ribbon, stating This is a 

recovered file that is temporarily stored on your computer.

5.

Click Save As.6.

SAVE the document as Unsaved Document in the lesson folder on your flash drive.7.

PAUSE. LEAVE the document open to use in the next exercise.

Step by step          Delete All Draft Versions

Click the File tab, click the Manage Document button, and then click Recover 

Unsaved Documents. An Open dialog box appears, displaying the contents of the 

UnsavedFiles folder.

1.

Right-click the Working with unsaved documents can be . . . file and, on the context 

menu, select Delete.

2.

Select Cancel to close the Open dialog box.3.

CLOSE the Unsaved Document file.4.

GET READY. USE the Unsaved Document document that is open from the previous 

exercise.

PAUSE. LEAVE Word open to use in the next exercise.
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PAUSE. LEAVE Word open to use in the next exercise.

Take Note

Word stores unsaved documents in a specific location on your hard drive, with a file 

extension of ASD. The files located in the UnsavedFiles folder are temporary files until 

you save them with a new file name.

Sharing Documents

Many of the documents created in a business environment will need to be shared with 

others. Before you share a document, it is important to ensure that the document has a 

professional appearance. Microsoft Word 2016 has three tools to help you with this: 

Document Inspector, Accessibility Checker, and Compatibility Checker. In addition, Word 

2016 makes it easy for you to share your documents with colleagues, clients, and others 

using several formats.

Using the Document Inspector

Word contains a feature that removes unwanted information from your document's 

properties. The Document Inspector can find and remove hidden data and personal 

information in Word 2016 documents, as well as earlier versions. It is a good idea to 

inspect a document before sharing an electronic copy, such as an e-mail attachment. In 

this exercise, you inspect a document and remove personal information.

Step by step          Use the Document Inspector

OPEN the Employment Offer Letter document from your lesson folder. Notice that 

the document opened in Compatibility Mode. Keep this in mind for later.

1.

OPEN Backstage, click the Check for Issues button, and then click Inspect 

Document. The Document Inspector dialog box appears (see Figure 3-13). This 

command checks for hidden properties and personal information.

2.

GET READY. LAUNCH Word if it is not already running.
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Figure 3-13

Document Inspector dialog box

Click the Inspect button. Word inspects the document and displays the results in 

the Document Inspector window. Three warnings appear in the Document 

Inspector, two of which are shown in Figure 3-14.

3.
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Figure 3-14

Document Inspector results

In the Document Properties and Personal Information section, click Remove All. 

Word removes personal information from the document properties and prepares 

the document to be shared. 

4.

Make no changes to the Task Pane Add-ins and Headers, Footers, and Watermarks 

sections.

5.

Click Close.6.

In the Inspect Document section, click the Allow this information to be saved in 

your file link.

7.

SAVE the document as Employment Offer Letter 1 in the lesson folder on your flash 

drive. A Microsoft Word prompt appears, stating Your document will be upgraded 

to the newest file format. Click OK.

8.

PAUSE. LEAVE the document open to use in the next exercise.

Checking Accessibility

The Accessibility Checker determines whether there are potential errors in your 

document and alerts you that the content might be difficult for an individual with a 

disability to read. Accessibility is defined as being accessible to those with disabilities. 

Before sharing your document, it is important to perform an accessibility inspection, in 
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Before sharing your document, it is important to perform an accessibility inspection, in 

case someone with a disability opens the document. In this exercise, you learn to check 

whether there are accessibility issues in your document.

Step by step          Use the Accessibility Checker

OPEN Backstage, click the Check for Issues button, and then click Check

Accessibility. The Accessibility Checker pane appears, as shown in Figure 3-15. If 

there are errors in your document, the Accessibility Check shows issues, warnings, 

or tips. In this case, a warning appears, specifying Objects Not Inline.

1.

Return to Backstage. A bullet below Inspect Document indicates that the document 

contains Content that people with disabilities find difficult to read.

2.

Return to the document.3.

Figure 3-15

Accessibility Checker pane

In the Accessibility Checker pane, select Text Box 1. A text box appears in the 

document with Blue Yonder Airlines in the background in very light text. Individuals 

with a disability could find this difficult to read.

4.

With the text box selected, change the font color to Green, Accent 1, Darker 50%.5.

Now that the color is changed on the heading, return to Backstage. The same 6.

GET READY. USE the Employment Offer Letter 1 document that is open from the 

previous exercise.
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Now that the color is changed on the heading, return to Backstage. The same 

warning appears because the object is not inline with text and a person with a 

disability might still experience problems reading it. 

6.

Return to the document. Select Text Box 1 and then press Delete.7.

Notice that the Accessibility Checker pane now displays No accessibility issues 

found.

8.

CLOSE the Accessibility Checker pane.9.

SAVE the document as Employment Offer Letter 2 in the lesson folder on your flash 

drive.

10.

PAUSE. LEAVE Word open to use in the next exercise.

If the document has multiple columns, make sure there is a substantial gap of 

white space between each column.

•

In tables, make sure the structure makes sense when read from left to right, row by 

row.

•

Set text descriptions (alt text) for each image.•

Make sure any hyperlinks have short text descriptions. •

Do not rely on your font, font size, and color choices being displayed correctly, 

particularly when viewed on multiple devices and platforms.

•

Make sure text color and its background contrast sharply, even in grayscale.•

Do not use text smaller than 10 points. •

When creating a document that may be read by people who use accessibility tools on 

their computers, such as narration for the blind, there are some additional ways you can 

make the document easier for them:

Checking Compatibility

Before sharing documents, it is good practice to check whether the document is error 

free and the formatting appears professional. It is also important to make sure other 

people will be able to open and read the document. Word's built-in Check Compatibility 

tool ensures that a document's features are compatible with other versions of Word. The 

Compatibility Checker searches a document for features that are not supported by 

earlier versions of Word and lists a summary of these features. When documents are 

saved in an earlier version and you open them in the latest version of Word, the 

filename appears in the title bar as filename.docx (Compatibility Mode). It is 

recommended that you run the Compatibility Checker to identify the features that are 

supported. For example, if you created a document that contained predefined horizontal 

lines and saved it in Word 2007, Word 2016 highlights this in the Microsoft Word 

Compatibility Checker dialog box. In this exercise, you learn to check for issues in a 

document.

Step by step          Use the Compatibility Checker

GET READY. USE the Employment Offer Letter 2 document that is open from the 

previous exercise. When documents are created in an earlier version of Word and 

opened in newer versions of Word, they open in Compatibility Mode and display in the 
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Go to Backstage, click Check for Issues, and then click Check Compatibility. The 

Microsoft Word Compatibility Checker dialog box appears, is displayed as in Figure 

3-16. The Compatibility Checker displays the message: The following features in this 

document are not supported by earlier versions of Word. These features may be lost 

or degraded when opening this document in an earlier version of Word or if you save 

this document in an earlier file format.

1.

Figure 3-16

Compatibility Checker dialog box

Take Note

When sharing Word 2016 documents with individuals using earlier versions of 

Word, your document will need to be saved in the Word 97-2003 format. It is good 

practice to use the Compatibility Checker to ensure the features you have included 

in your document will not be removed or changed when you save it in the Word 

97-2003 format.

Click OK.2.

SAVE the document as Employment Offer 20XX (replace XX with the current year) 

and make sure the file type displays as Word Document.

3.

opened in newer versions of Word, they open in Compatibility Mode and display in the 

title bar. Previously, you opened the Employment Offer Letter and it opened in 

Compatibility Mode. Even though you no longer see Compatibility Mode on the title 

bar, this document still contains features from an older version that are no longer 

supported by the latest version of Word. It is recommended that you run the 

Compatibility Checker to identify features that are supported in older versions

PAUSE. LEAVE the document open to use in the next exercise.

Sending Documents
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Sending Documents

Electronic documents can be sent via e-mail, web, and Internet fax. In Backstage, you 

can save the document in PDF and XPS format, or attach it to an e-mail. You can also 

change and create a document in different file formats. In this exercise, you send a 

document by e-mail and OneDrive and use the online presentation.

Step by step          Send Documents via Email Using Outlook

GET READY. USE the Employment Offer 20XX document that is open from the previous 

exercise.

Take Note

For this exercise, you must use Microsoft Outlook 2016. If you are unsure, check with 

your instructor to determine whether you have access to Microsoft Outlook 2016 on 

your computer.

OPEN Backstage and then click Share. The Share page appears, displaying the 

options for sharing the document with others.

1.

Click Email. The various options on how you can send the document appear, as 

shown in Figure 3-17. The document can be e-mailed as an attachment, you can 

send it as a PDF or XPS file, or as an Internet fax. There is also an option to send 

the document as a link, but it is grayed out, because it must be saved to a shared 

location first.

2.

Figure 3-17

Share e-mail options
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Select Send as Attachment. An Outlook message form appears with the document 

included as an attachment (see Figure 3-18).

3.

Type the [email address] of a friend, classmate, or coworker in the To box, type a 

short message, and then click the Send button.

4.

Figure 3-18

Outlook message with document attached

PAUSE. LEAVE the document open to use in the next exercise.

OneDrive is an online service provided by Microsoft. OneDrive is an online file storage 

location where you can store your documents and media files. At the time of this 

publication, Microsoft provides OneDrive members with 15 GB of free online storage 

space for personal use. OneDrive is password protected—so you control who has access 

to your files. You can access your files on OneDrive anywhere and anytime, from any 

computer, tablet, or smartphone with Internet access.

OneDrive can store any type of document, but it is best for sharing documents in Word, 

Excel, PowerPoint, and OneNote. You can also create a personal album to share pictures 

with your contacts or on your social networking site; create and send e-mails; manage 

your contacts; add events to your calendar; and stay updated and connected to your 

social networking sites.

Take Note

The information about OneDrive, the login information, and the images are all current at 

the time this book was published. Things change frequently on the web and OneDrive is 

no exception. Please check the OneDrive website or use Bing to search for more up-to-

date information.
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date information.

Step by step          Send Documents via OneDrive

Go to Backstage and then click Account. The Account page appears.1.

Sign in with your Microsoft account, if necessary. 2.

Once you are connected, the Account screen changes and your personal profile 

appears (see Figure 3-19).

3.

In the Office Background drop-down list, select Calligraphy. Look at the upper-

right corner as the screen background changes.

4.

In the Office Theme drop-down list, select Dark Gray and watch how the 

background color darkens. 

5.

Figure 3-19

Account screen

Change the Office Theme setting back to White.6.

Click Share on the left pane. Under Share with People, click Save to Cloud. The 

screen changes to the Save As screen. 

7.

Select OneDrive. On the right side of the screen, the folders in your OneDrive 

appear.

8.

Click OneDrive - Personal. The Save As dialog box appears.9.

GET READY. USE the Employment Offer 20XX document open from the previous 

exercise. For this exercise, you need a Microsoft account. If you have a OneDrive, 

Outlook, Hotmail, Xbox Live account, or other Microsoft service account, then you 

already have a Microsoft account. If you need a Microsoft account, launch your browser 

and complete the steps as listed in the website at https://signup.live.com/.
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Click OneDrive - Personal. The Save As dialog box appears.9.

Click Save to save your document to the OneDrive folder.10.

Once the file is saved, return to Backstage, click Share, and then click Share with 

People again. The document appears, with a Share pane (see Figure 3-20). You can 

now share the document with anyone by sending them an invitation to edit or view 

the document

11.

Figure 3-20

Share pane

Select someone in class and then type his or her [email address] along with a short 

message. 

12.

Click the Share button and an e-mail is automatically sent to him or her. When he 

or she opens the e-mail, a link to the document appears. Clicking the link opens 

the document in the Microsoft Word Web App. 

13.

Take Note

The individual receiving the e-mail must be signed in to a Microsoft account before 

editing the document.

CLOSE the Share pane.14.

PAUSE. LEAVE the document open for the next exercise.

Step by step          Present Online

get ready. USE the Employment Offer 20XX document open from the previous exercise. 

Sharing a Word document by using the Present Online feature is easy because there is 

no setup. The Present Online feature enables you to create a link to your document and 

present to others, even if they do not have Word installed on their computers. The link 

that you create will open in a browser. In this exercise, you create a link to share your 
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In Backstage, select the Share group.1.

Click the Present Online button.2.

Read the Service Agreement and then select the Enable remote viewers to 

download the document checkbox. Click Present Online to connect to Office 

Presentation Services. You have two options available on how to present. You can 

select Copy Link or Send in Email—send an invitation that links to your 

presentation.

3.

Click Start Presentation. Your screen should match Figure 3-21. You can send 

invitations and invite others to view your presentation and if you need to edit the 

document, you can do so in the same screen.

4.

Figure 3-21

Present Online screen

Click End Online Presentation. A warning prompt appears and states, All people will 

be disconnected if you continue. Do you want to end this online presentation?

5.

Click End Online Presentation.6.

CLOSE the file. When you close the file, you will be prompted to save and then the 

file will be saved to your OneDrive account.

7.

that you create will open in a browser. In this exercise, you create a link to share your 

document with others in a web browser

STOP. CLOSE Word and then CLOSE the Internet connection.
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Multiple Choice

Restrict Formattinga.

Protected from using commentsb.

Comments features was turned offc.

Editing Restrictionsd.

A document that is protected from editing, but allows comments is protected using 

which of the following features?

1.

multiple users.a.

Manage Document.b.

OneDrive.c.

Save As.d.

Unsaved documents can be recovered using which of the following?2.

Check Accessibilitya.

Check Compatibilityb.

Inspect Documentc.

All of the aboved.

Which of the following commands would alert you if your document contains 

potential problems causing the content to be difficult to read by an individual with 

a disability?

3.

Check Accessibilitya.

Check Compatibilityb.

Inspect Documentc.

No command is availabled.

Before sharing a document, it is good practice to remove personal information 

using which command?

4.

right-clicking and then selecting Delete.a.

using Manage Document.b.

pressing the Delete key.c.

a and bd.

Draft versions of documents can be deleted by: 5.

Select the best response for the following statements.

True/False

Circle T if the statement is true or F if the statement is false.

T F The Compatibility Checker ensures that the document's features are 

compatible with other versions of Word.

1.

T  F The Compatibility Checker lists a summary of features not supported by 

earlier versions.

2.

T F OneDrive is a way to share documents.3.

T F Formatting restrictions enable users to limit the styles applied in a 

document.

4.

Knowledge Assessment
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document.

T F Read only prevents changes to a document.5.
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Project 3-1: Formatting a Document

In this project, you will format a coffee menu document and have it ready for a meeting 

within the hour.

OPEN the Coffee Menu document from the lesson folder.1.

Go to Backstage, click Options, and then click Save.2.

Under the Save section, change the Save AutoRecover information every setting to 

3 minutes and then click OK.

3.

Select the heading Grand Street Coffee Shop.4.

Change the font color and then select Purple, Accent 4, Lighter 80%.5.

Change the page border to a Shadow style with the border color of Purple, 4 ½ pts

wide.

6.

Select Menu and then change the font size to 26 pt bold italics.7.

Change the font to Cambria and the color to Purple, Accent 4, Darker 50%.8.

Select Menu and use the Format Painter and apply the format to Nutritional 

Information.

9.

Apply a page color and then select Purple, Accent 4, Lighter 80%.10.

CLOSE the document without saving. A prompt should appear, saying If you don't 

save, a recent copy of the document will be temporarily available.

11.

Click Don't Save. In the next exercise, you recover your unsaved document.12.

GET READY. LAUNCH Word if not already running.

Pause. LEAVE Word open for the next project.

Project 3-2: Managing Versions

In this project, you will continue with the previous project. You have realized that you 

inadvertently didn't save the document. Your task is to retrieve the unsaved document.

OPEN a new blank document.1.

Go to Backstage and then click the Manage Document button.2.

Select Recover Unsaved Documents.3.

Locate the unsaved file, click Open, and then click Restore.4.

SAVE the document as 3-2 Coffee Menu in the lesson folder on your flash drive 

and then CLOSE the file.

5.

GET READY. LAUNCH Word if not already running.

CLOSE Word.

Projects
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